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AERMOD View™ Version 8.5 

Release Notes 

January 21, 2014 

New Features 

Topic Feature Description 

Models Latest Releases of US EPA Models Available 

The following US EPA Models were released since December 2013 and are 

incorporated into AERMOD View Version 8.5: 

1. AERMOD Model 13350 (Released Dec 2013) 

2. AERMET Model 13350 (Released Dec 2013) 

 

Note:  AERMOD 13350 will not run using met data created using 

AERMET 11059 or earlier. Old met data must be re-processed using a 

more recent version of AERMET (preferably 13350), or the modeler must 

use an older version of the AERMOD model. 

AERMOD 

MPI 

New Version of Lakes AERMOD MPI 13350 (Parallel Version) 

A new version of the Lakes AERMOD MPI for the US EPA Model Version 

13350 is now available (AERMOD_MPI_Lakes_13350.exe).  You can 

specify to use this model under the Preferences dialog. 

 

Note: AERMOD_MPI_LAKES_13350.EXE or AERMOD_MPI_LAKES.EXE will 

run the latest version of the AERMOD model (13350) in parallel mode 

using up to a maximum of 8 cores. 
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Topic Feature Description 

Control 

Pathway 

New NO2 Modeling Methods 

The U.S. EPA incorporated two new options for modeling NO2:  the 

Ambient Ratio Method (ARM) and the Ambient Ratio Method – 2 

(ARM2). ARM can be modeled as a Regulatory Default option while ARM2 

is a non-default BETA option. 

 

Control 

Pathway 

Vary Background Ozone by Downwind Sector 

Introduced with AERMOD 13350, background ozone concentrations can 

now vary by downwind sector. Sectors are defined by the flow vector 

(direction the wind blows towards). The original background ozone 

variance options (including hourly emission files) are applied to each 

individual sector. 
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Topic Feature Description 

Control 

Pathway 

Background Ozone Options Moved 

The Background Ozone options used with the OLM and PVMRM model 

options have been relocated to their own window (CO Pathway – 

Background Ozone). 

Control 

Pathway 

New Debug Files 

Introduced in AERMOD 13350, users can now create separate debug files 

containing: 

• PRIME downwash parameters, 

• Gas and particle deposition output, and  

• NO2 model options (OLM, PVMRM, ARM, or ARM2). 

 

Source 

Pathway 

Import/Export of Line Volume and Line Area Sources 

Line Volume and Line Area sources can now be exported to and imported 

from AERMOD View projects using the Lakes Format Template source 

parameters spreadsheet. Details are included in the Help file. 
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Topic Feature Description 

Source 

Pathway 

Vary Background Concentrations by Downwind Sector 

Introduced with AERMOD 13350, background concentrations can now 

vary by downwind sector. Sectors are defined by the flow vector 

(direction the wind blows towards). The original background variance 

options are applied to each individual sector. 

 

Source 

Pathway 

New Line Volume Source Configuration 

Adds a third configuration to line volume sources:  Separated 2W. This 

option follows the original ISCST3 model guidance for placement of 

separated volume sources (center-to-center distance = 2 * length of 

side). 

The existing Separated method is still available. This method places 

sources at the start and end nodes then calculates an even center-to-

center distance for all other sources along the line. 
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Topic Feature Description 

Source 

Pathway 

Modified Seasonal Labels for Southern Hemisphere 

When the Map Projection is set to the Southern Hemisphere, all seasonal 

labels (e.g., Background Concentrations, Variable Emission Rates) are 

reversed and display what months apply to each value. 

 

Printouts Maximum Value Decimal Places 

The maximum value field shown in the Printout is now controlled by the 

“No. Decimal Places” field in the Graphical Options Contours Color 

Ramp settings. The full maximum value to 5 decimal places is still 

displayed in the Contours Panel. 

 

AERMOD 3D Visualization and Control Enhancements 

The AERMOD 3D View has been updated to include several new features: 

• Quick-zoom to sources and buildings using new toolbar button  

• Introduces vertical exaggeration scale 

 

• New mouse controls:  left-click and pan to change viewing angle, 

right-click and pan to change center point. 
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Topic Feature Description 

Met View Export SFC & PFL Files to CSV and Excel 

Surface (.SFC) and Profile (.PFL) files can be exported from Met View to 

CSV or Excel spreadsheet. The exported file contains all column headers 

and unit descriptions. 

 Export button is available in Met View window. 

 

AERMET 

View 

New US EPA AERMET Model Version 13350 

On December 16, 2013, the US EPA released a new version of the 

AERMET model (13350). For a complete description of the changes, 

please see the US EPA Model Change Bulletin #4 (MCB#4). 
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Topic Feature Description 

AERMET 

View 

Preferences Option for AERMET Model Version 

AERMET 13350 was added as the default model version. The 

Preferences menu was modified to include a drop-down menu for model 

executable selection. You can select from AERMET 13350 (the default and 

recommended), AERMET 12345, or AERMET 11059. 

The AERMET View Project Status dialog will display the model version 

being used when you run AERMET. 

Note: The option to select AERMET 11059 is still available in the AERMET 

View interface for backward compatibility; however modelers should 

always use the latest versions of the US EPA models.  
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Topic Feature Description 

AERMET 

View 

Cloud Cover and Temperature Substitution Options 

Introduced with AERMET 13350, the model will substitute ambient 

temperature and cloud cover across 1- and 2-hour gaps. Both options are 

enabled by default when only one of the Surface and Onsite pathways is 

used. 

When both Surface and Onsite pathways are used, the options are 

disabled by default. 

 

AERMET 

View 

Use Onsite Pathway Only 

AERMET 13350 allows users to bypass the Upper Air pathway entirely 

when mixing heights are read from Onsite data. Users must specify the 

local time zone for the modeling site when using this option. 
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Topic Feature Description 

AERMET 

View 

Sectors Modifications 

The Sectors options have been modified to make inputs more 

transparent for projects located in the Southern Hemisphere where 

seasons are reversed from AERMET defaults. 

• The Hemisphere (North or South) is noted 

• Season definitions are now listed as the month range instead of 

the season name.  

 

AERMET 

View 

Added Version and Date Period Details 

The Output Files tab now includes version number and options, selected 

model options, start date, and end date for the Surface and Profile files. 

 

AERMET 

View 

Upper Air Estimator Updated for AERMET 13350 

Lakes Environmental Upper Air Estimator tool was updated for 

compatibility with the latest release of the US EPA AERMET 13350. 
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Fixed Issues 

Topic Issue Description 

Save 

Project As 

Renamed Met Data Files 

When meteorological data files had an identical name to a project, the file 

names were changed when running the Save Project As menu option. The 

option now maintains the original path to the met data files. 

Control 

Pathway 

Ozone File Maker Update 

The “Auto Populate for Missing Hours” option in the Hourly Ozone 

Concentration File Maker utility was removed. When building the file, the 

utility automatically adds a missing indicator (-99) to all blank cells. 

 

Source 

Pathway 

Gas & Particle Data Fixes 

Fixed a bug which did not write deposition parameters to sources with IDs 

longer than 10 characters. Also fixed an issue with the Copy and Paste 

functions. 

Source 

Pathway 

Line Volume Source Coordinates 

Expanded the number of source node coordinates written to the model 

input file so coordinates of individual sources along the line can be 

recreated. 

Reports Missing Fields 

Fields like Pollutant Type in the Control Pathway report went missing for 

certain values. This has been fixed. 

Contours 

Panel 

Shortened Plotfile List 

Removed the full project folder path from the Plotfile List menu to make 

file names shorter. Previous versions occasionally had issues with paths 

that extended beyond the available space. 

Color Ramp Duplicate Title 

Fixed an issue with the original Color Ramp title remaining after 

renaming. 
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Topic Issue Description 

WRPLOT 

View 

Miscellaneous Updates 

Updates include: 

• New default “Files of type” set to All Files when adding files 

• Setting Wind Classes display to show 2 decimal places and refined 

conversions between m/s and knots. 

• Bug fixes to the Data File Info panel when multiple files or years of 

data are analyzed. Fixes include displaying the proper number of 

missing records and total number of hours when the Date Range is 

modified. 

• Inclusion of February 29 in the Specify Days option when a leap 

year is present. 

• All percentages normalized to the total number of hours. Previous 

versions would correct calm frequencies to remove missing 

records. 

• Modification to reading TD-3505/ISHD files to match code from 

AERMET. The program now reads observations found between :30 

of the previous hour and :01 of the current hour. 

• Added XLSX support to the Import Surface Data from Excel utility. 

• Modifications to the Years and Time Range fields to allow subsets 

of multiple years and overnight hours to be analyzed. 
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AERMOD View™ Version 8.2 

Release Notes 

April 18, 2013 

New Features 

Topic Feature Description 

Install Web License Automatically Deactivated During Uninstall 

If you have a Web License and you uninstall AERMOD View using the 

uninstall feature from the Windows Control Panel then your web license 

will be automatically deactivated as long as an internet connection was 

available during the uninstall. 

HASP 

License 

HASP Key License Requires Update 

AERMOD View Version 8.2 requires the renewal/update of the HASP Key 

License.   

If you are under current maintenance and you have the HASP Key license, 

than you will receive your HASP renew code with the release email.  

Instructions on how to update/activate your HASP Key license are 

provided in the installation instructions document available in the update 

site. 
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Topic Feature Description 

Reports Updated Reports Template and New Results Summary  

The Reports template was updated to include new model features. The 

Results Summary was also added for standard or multi-chemical runs.  

The report contains tables summarizing model output concentrations or 

deposition fluxes. 

 

Preferences Select Default Text Editor  

Users can now specify the default text editor for opening project input and 

output files under the File | Preferences options. 
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Topic Feature Description 

Labels Control Labels for Large Numbers of Objects 

Previous versions of AERMOD View restricted control of individual labels to 

the first 1,000 objects of a single type for performance purposes. Users 

can now select the “Show All” checkbox on the Labels Tree Menu to 

control individual labels of all objects.  

Base Maps Transparency Option for Raster Images 

Users can set image transparency when importing raster image base 

maps. 

Source 

Pathway 

NO2/NOx Ratios for Line-Area and Line-Volume Sources 

In-Stack NO2/NOx ratios are now available for Line Area and Line Volume 

source types. The specified ratio applies to all sources in the line. 

Source 

Pathway 

Improved Error Handling When Importing Deposition Data 

A list of errors is available when importing deposition parameters to the 

Gas & Particle Data source options. 

Met 

Pathway 

Updated Vector Mean Wind Option 

Enabled the “Wind Speeds are Vector Mean” option for default and 

non-default control options.  This option was moved from the Control 

Pathway window to the Meteorology Pathway window. 
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Topic Feature Description 

Met 

Pathway 

Expanded Data Period Options 

The “Specify Data Period to Process” and “Specify Particular Days and/or 

Ranges of Days to Process” can now be used simultaneously. 

 

Details Incomplete Project Message with Incompatible Met Data 

An error message is issued if met data processed using the 06341 version 

of AERMET (or earlier) is input when using the AERMOD 12345 

executable. 

AERMET 

View 

XLSX Support in the Import Surface Data from Excel Tool 

Users can now input XLSX files to the Import Surface Data from Excel 

utility to support larger datasets (>65536 rows). 
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Fixed Issues 

Topic Issue Description 

Control 

Pathway 

Fixed BETA Options Error 

Fixed an issue where the program looked for user-specified Low Wind 

Parameters associated with LOWWIND2 even when the LOWWIND1 option 

was selected. 

Source 

Pathway 

Display Base Elevation for Line-Area Sources 

Fixed an issue in the Source Summary table where the Base Elevation 

column was empty for Line Area sources. 

Source 

Pathway 

Corrected Source Import for Line-Area Sources 

The Import Sources routine was fixed to properly import all source 

parameters from Line-Area source types. 

Risk Mode Various Risk Mode Options 

• Multi-Tier grid not displayed when created using the Risk Mode | 

Risk Grid… menu option. 

• Copy-and-paste functions of Risk Emission Phase Data menu 

were not working properly. 

Terrain 

Processor 

Error Converting NED GridFloat to GeoTIFF 

A component was missing that was necessary for converting NED terrain 

data downloaded from WebGIS from its native GridFloat format to the 

AERMAP-accepted GeoTIFF format. The missing component is now 

included in the install package. 

Multi-

Chemical 

Utility 

Urban Groups with Line-Area and Line-Volume Sources 

Resolved an issue where the URBANSRC keyword was not correctly 

applied to line sources. 

AERMET 

View 

Multiple STABLEBL Keywords 

AERMET View now accepts the BETA adjust U* option and the ONSITE 

Bulk Richardson Number scheme option in the same run. The previous 

release only allowed the STABLEBL keyword to be used once. 
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AERMOD View™ Version 8.1 

Release Notes 

January 25, 2013 

New Features 

Topic Feature Description 

Install Compatibility with Windows 8, 32-Bit and 64-Bit 

AERMOD View Version 8.1 is compatible with Microsoft Windows 8, 32-bit 

and 64-bit versions. 

 

AERMOD MPI (Parallel Version) requires the installation of MPICH2, which 

requires that .NET Framework 3.5 is installed in your computer.  As 

opposed to Windows 7 and XP, Windows 8 does not automatically install 

.NET Framework 3.5. The user must manually select it before installing 

MPICH2 1.4.1.  Instructions are provided in the AERMOD View Installation 

Notes. 

 

Models Latest Releases of US EPA Models Available 

The following US EPA Models were released since Dec/2012 and are 

incorporated into AERMOD View Version 8.1: 

3. AERMOD Model 12345 (Released Dec 2012) 

4. AERMET Model 12345 (Released Dec 2012) 

5. AERSURFACE Model 13016 (Released Jan 2013) 
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Topic Feature Description 

AERMOD 

MPI 

New Version of Lakes AERMOD MPI 12345 (Parallel Version) 

A new version of the Lakes AERMOD MPI for the US EPA Model Version 

12345 is now available (AERMOD_MPI_Lakes_12345.exe).  You can 

specify to use this model under the Preferences dialog. 

 

Note: AERMOD_MPI_LAKES_12345.EXE or AERMOD_MPI_LAKES.EXE will 

run the latest version of the AERMOD model (12345) in parallel mode 

using up to a maximum of 8 cores. 

 

Control 

Pathway 

New Non-Default Options in Control Pathway 

New Non-Default BETA options have been added to the Control Pathway 

supporting the new options introduced in the US EPA AERMOD Model 

12345. These options address model performance concerns in low wind 

speed conditions:  

• METHOD STABLEBL ADJ_U*: adjust surface friction velocity. 

• LOWWIND1: increases minimum horizontal turbulence and turns off 

horizontal plume meander. 

• LOWWIND2: increases minimum horizontal turbulence and 

incorporates a modified meander component. 

Users can input a user-specified minimum sigma-v, minimum wind speed, 

and maximum meander factor in conjunction with the LOWWIND1 and 

LOWWIND2 options. 

 

An additional option was introduced that allows users to specify that input 

wind speeds are vector means not scalar means. 
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Topic Feature Description 

Source 

Pathway 

New Line Source Type Introduced 

A new source type, LINE, was introduced in the US EPA AERMOD Model 

12345. This new LINE source is an alternative to the current AREA source 

type for rectangular sources.  

The LINE source type, specified as 1 line segment with start/end points 

and width, utilizes the same routines as the AREA source type, and will 

give identical results for equivalent source inputs. 

A graphical tool was implemented in AERMOD View for this new source 

type. 

 

 

Terrain 

Processor 

Updates to the Download of NED Terrain Data 

The feature to download NED terrain data from the USGS site, introduced 

in AERMOD View Version 8, was updated.   

 

Beginning December 18, 2012, the USGS 

National Map Server no longer offers download 

of NED data in GeoTIFF format, which is the 

format accepted by AERMAP. NED 1 and 1/3 

arc-second data is now only available through 

1- degree tiles in ArcGrid and GridFloat formats. 

 

Lakes Environmental incorporated in AERMOD View 8.1 a seamless 

conversion of downloaded 1-degree GridFloat tiles into the GeoTIFF 

format. 

 

Note: Support for non-CONUS areas (Hawaii, Alaska, and Puerto Rico) 

was also implemented. 
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Topic Feature Description 

Met 

Pathway 

Version and Processing Parameters Shown 

Under the Met Pathway, the Version number of the specified Surface Met 

file (*.SFC) will be displayed for your verification (e.g., Version 12345).  

This version corresponds to the US EPA AERMET version that was used to 

preprocess the met file.  

 

If you preprocessed your met data using the new AERMET options 

introduced in version 12345 (THRESH_1MIN and ADJ_U*), then these 

options will also be indicated after the version number. 

 

General Options to Undo/Redo Changes 

You can now Undo or Redo Move/Rotate/Resize changes to graphical 

model elements (e.g. annotations) using the Edit | Undo and Edit |Redo 

options. 

 

Import/ 

Export 
Updated Functionality for Import/Export of Excel Files 

Previous versions of AERMOD View required that you have Microsoft Excel 

installed in your computer in order to use the Import/Export from Excel 

file (*.XLS) functionality. Starting with AERMOD View 8.1, you no longer 

need to have Excel installed on your machine. 
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Topic Feature Description 

Export Support for Excel *.XLSX Format 

The number of columns supported for the import/export of source 

parameters (specifically related to X,Y coordinates for polygonal area 

sources with many vertices) was limited to 256 columns which is a 

limitation of Excel 2003 (*.xls).   

In AERMOD View 8.1 during export you can select to save the data as an 

MS Excel 2007 Format (*.xlsx) which allows for more than 256 columns. 

 

Base Maps Grayscale Option for Tile Maps 

You can now select to import Tile Maps in grayscale instead of in color. 
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Topic Feature Description 

AERMET 

View 

New US EPA AERMET Model Version 12345 

On December 17, 2012, the US EPA released a new version of the 

AERMET model (12345). For a complete description of the changes, 

please see the US EPA Model Change Bulletin #3 (MCB#3). 

AERMET 

View 

New US EPA AERSURFACE Version 13016 

On January 18, 2013, the US EPA released a new version of AERSURFACE 

(13016). This latest EXE is now part of AERMOD View 8.1 and it is used 

by default.  This new version contains bug fixes and enhancements within 

the code. For a complete description of the changes, please see the US 

EPA Model Change Bulletin #1 (MCB#1). 

Note: Changes incorporated into the US EPA AERSURFACE 13016 are 

only internal to the code.  The AERSURFACE interface options within 

AERMET View remain the same. 

AERMET 

View 

Preferences Option for AERMET Model Version 

Under the Preferences dialog, you have the option to select the US EPA 

AERMET version you want to run: AERMET 12345 (the default and 

recommended) or AERMET 11059. 

The AERMET View Project Status dialog will display the model version 

being used when you run AERMET. 

Note: The option to select AERMET 11059 is still available in the AERMET 

View interface for backward compatibility; however modelers should 

always use the latest versions of the US EPA models.  
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Topic Feature Description 

AERMET 

View 

Threshold Wind Speed Option for AERMINUTE Output 

Introduced with AERMET 12345 is the option to specify a wind speed 

threshold for 1-minute ASOS winds output by AERMINUTE.  This value will 

be used by AERMET in Stage 3. 

There is no default value; however, a warning message will be generated 

if the user-specified threshold is greater than 0.5 m/s, and a fatal error 

message will be generated if the user-specified threshold is less than zero 

or greater than 1.0. 

 

AERMET 

View 

AERMINUTE – IFW Installation Date 

Now the AERMINUTE Utility automatically checks if the ASOS surface 

station being used is part of the Ice Free Winds (IFW) group and if so, it 

automatically specifies the date of the installation. 
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Topic Feature Description 

AERMET 

View 

BETA Option to Adjust Surface Friction Velocity (ADJ_U*) 

Introduced with AERMET 12345, a new BETA option is available to adjust 

surface friction velocity (u*) for low wind speed stable conditions. This 

option is considered a non-Default option and is subject to regulatory 

review.  

Note: Use of this option also requires the user to select the Non-Default 

BETA option on the AERMOD Control Pathway. 

 

AERMET 

View 

Upper Air Estimator Updated for AERMET 12345 

Lakes Environmental Upper Air Estimator tool was updated for 

compatibility with the latest release of the US EPA AERMET 12345. 

 

RAMMET 

View 

Fill in Missing Data Option for Mixing Height File 

Fill in missing data option for mixing height files generated by the Mixing 

Height Estimator. 
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Fixed Issues 

Topic Issue Description 

Base Maps Base Maps Not Transferred to the New Saved Project As 

AERMOD View 8.0.5 did not transfer the reference to imported base 

maps/tile maps to the new project when using the “Save As Project” 

option. This issue has been fixed in AERMOD View 8.1. 

Source 

Pathway 

Gas & Particle Data – Method 2 with Non-Default Option 

Issue of not being able to select the Non-Default Method 2 option under 

the Source Pathway – Gas & Particle Data window with only the Non-

Default option selected in the Control Pathway was resolved. 

MAKEMET 

Utility 

Surface Roughness Value for Water Fixed 

Under the MAKEMET Utility (accessed from the Tools menu), when the 

water land use category was selected, a surface roughness of 0.0 was 

being specified instead of 0.0001 due to the limitation on the number of 

decimal places allowed in the field.  This issue has been resolved. 
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AERMOD View™ Version 8.0.5 

Release Notes 

October 11, 2012 

New Features 

Topic Feature Description 

Graphical 

Options 

Colored Contour Lines 

Contour Lines and Terrain Contour Lines can now be colored to match the 

contour level colors.  This option is available under the Graphical 

Options – Smoothing panel.  

 

Buildings Map Layers Available under Preview in Building Inputs Dialog  

The Preview display of the Building Inputs window now includes all base 

maps as layers. 
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Topic Feature Description 

Export New Google Earth Export Options 

The Export to Google Earth feature now includes: 

• Plant Boundary Receptors 

• Exporting contour lines only, without shading 

Source 

Pathway 

In-Stack NO2/NOx Ratio List Update 

Enhanced the In-Stack NO2/Nox Ratio table to display more digits. 

Meteorology 

Pathway 

Onsite Station Information Extracted from SFC Met File 

Onsite station ID number and year are automatically populated if the SFC 

file contains onsite station information. 

 

Details Additional Warnings in Details 

AERMOD View will now warn you if the urban dispersion option is enabled 

and a population value is not input for urban groups. 
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Topic Feature Description 

AERMET 

View 

Sectors and 3-Km Radius Exported to Google Earth 

When exporting AERMET View project information to Google Earth, a 3-

kilometer radius and outline of specified sectors is now included for the 

surface met station and/or onsite met station.  This feature is especially 

useful for users that need to specify the land use type and sectors by 

hand. 

 

AERMET 

View 

Improvements for the Onsite Data Formatting Options 

When identifying onsite variables, single- and multi-level variables are 

now listed in a single table so that users can specify any order. 

Also implemented is the full description for each onsite variable and 

expected units. 

The unit for the onsite precipitation variable “PRCP” was changed from 

mm to mm*100 as required by the US EPA AERMET dated 11059. 
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Topic Feature Description 

AERMET 

View 

Full Descriptions for QA Variables 

Surface and Upper Air Variables that you select for QA now display their 

full description and expected units. 

 

AERMET 

View 

Disabled Unsupported Options for Onsite Only Option 

If the “Surface Data from Onsite Only” option is enabled, model options 

that only apply to hourly surface data are disabled including anemometer 

height and data substitution selection. 

 

AERMET 

View 

Additional Warnings for AERMET View 

Additional warning messages were implemented related to the adjustment 

from GMT to local standard time (LST) for hourly surface data, onsite 

data, and upper air data. 
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Fixed Issues 

Topic Issue Description 

Terrain 

Processor 

Automated Download of NED Terrain Data Connection Issue 

Starting in AERMOD View Version 8.0 users can now automatically 

download USGS National Elevation Dataset (NED) terrain data files for 

projects located in the United States. 

 

On the first week of October 2012, the USGS changed the server 

parameters and settings that allowed third party programs to 

automatically download the NED terrain data from their servers.  Users of 

AERMOD View trying to download the NED terrain data started receiving 

messages that a connection with server could not be established. 

 

AERMOD View Version 8.0.5 contains a solution to this issue. 

 

 

 

NOTE: This feature is only available for users with current maintenance. 

If you are receiving this update as part of your maintenance, once your 

maintenance expires, you will no longer have access to this feature. 
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Topic Issue Description 

Reports Generate Reports Error 

Version 8.0 contained a bug which prevented AERMOD View from creating 

or displaying reports. This issue has been resolved. 

 

Output 

Pathway 

Creation of the Exceedance Plot File Fixed 

Fixed a bug in which the Threshold Violation File was created but the 

Exceedance Plot File was empty. 

Base Maps Raster Image Optimization 

Updated the Import | Base Maps | Raster Images option to resolve 

two issues: 

1. Coordinates embedded in geo-referenced GeoTIFF images are now 

read by the program even if a corresponding .tfw file is not 

present. 

2. The preview display of the Import Base Maps window would not 

show some large base maps. 

Multi-

Chemical 

Utility 

Multi-Chemical Utility Storage/Memory Error 

Fixed a problem resulting in Multi-Chemical runs failing due to a lack of 

storage or memory. 

Buildings Building Tiers in Wrong Order 

Resolved a bug in which building tiers were ordered differently in the main 

display and the Building Inputs window. Tiers are now ordered 

automatically from shortest to tallest. 
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Topic Issue Description 

Source 

Pathway 

Adding Line Source Nodes 

Resolved an issue where adding line source nodes in the Source window 

created a row which could not be selected. 

AERMOD 

MPI 

New Version of AERMOD MPI 12060 (Parallel Version) 

A new update of the Lakes AERMOD MPI for the US EPA Model Version 

12060 is now available and it will replace the exe provided with AERMOD 

View Version 7.6 (AERMOD_MPI_Lakes_12060.exe).   

This new compiled AERMOD MPI executable contains fixes to an issue only 

found for projects using the Multi-Year Analysis option (MULTYEAR 

keyword).  The MULTYEAR option requires the user to run 5 separate 

years of met data using five different AERMOD runs.  The MULTYEAR 

option requires the previous year initialization file to be provided for each 

subsequent year run.   
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AERMOD View™ Version 8.0 

Release Notes 

September 5, 2012 

New Features & Fixed Issues 

Topic Feature Description 

Base Maps Automated Download of Worldwide Geo-Referenced Base Maps  

The Import Tile Maps feature allows users to import imagery from 

various online resources. The program comes loaded with 6 different Map 

Servers which range from road maps (e.g., OpenStreetMap, MapQuest 

Streets) to Satellite and Aerial photography (e.g., MapQuest Satellite, 

CloudMade Maps). Additional Map Servers can be added by the user. 

 

Simple Steps: 

Step 1: Create your AERMOD View project. 

Step 2: Select Import | Tile Maps menu option. 

Step 3: Select Map type (e.g., OpenStreetMap) and click OK. 
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Topic Feature Description 

 

Downloaded imagery is stored locally. Check the File | Preferences | 

World Map Settings to add Proxy Server details. 

 

NOTE: The Import Tile Maps feature is only available for users with 

current maintenance. If you are receiving this update as part of your 

maintenance, once your maintenance expires, you will no longer have 

access to this feature. 

Models New AERMAP MPI Executable (8-Core) 

A parallelized version of the AERMAP executable (11103) has been added 

to AERMOD View. AERMAP MPI will work on up to 8 processors, and it 

significantly reduces runtimes when processing elevation data especially 

with complex file formats like the 10-meter National Elevation Dataset 

(NED) tiles. 

See the Getting Started – AERMOD MPI & AERMAP MPI document, 

available in the update site, for further instructions. 
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Topic Feature Description 

Import 

Buildings 

from DXF 

Additional Options for Importing Buildings from DXF 

• Layer to Import: Import more than one layer containing buildings. 

• Offset Option: Allows you to shift your buildings in the project 

domain (e.g. convert a local Cartesian coordinate system to UTM). 

 

Base Maps Improved Method of Importing Multiple Georeferenced Base Maps 

 

Using this feature allows you to search for multiple base maps, which 

already contain georeferenced world files, located in the same folder and 

import them either as a single layer or as separate maps. 
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Topic Feature Description 

Base Maps Import Raster Images 

You can now import any supported raster image file (e.g., BMP, JPEG, 

TIFF, etc.) using the same option in the menu. 

 

Tools New LEADPOST Executable in LEAD Post-Processor 

AERMOD View now uses the latest version of LEADPOST (12114) in the 

LEAD Post-Processor Utility.  LEADPOST Version 12114 was released by 

the US EPA on April 2012. 

Source 

Pathway 

Input Total Line Emission Rate for Line Area Sources 

The emission rate for the Line Area source can now be input as the total 

emission rate for the entire line instead of the emission rate per unit area. 

The area sources along the line must be generated before the total line 

emission rate can be entered. 

 

Source 

Pathway 

Line Volume Source Emission Rates – Issue Fixed 

Fixed issue in which a fatal error was generated if a line source emission 

rate was an integer instead of a real number (e.g., 1E-5 instead of 1.0E-5 

or 0.00001). Program now creates a real value. 
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Topic Feature Description 

Terrain 

Processor 

Automatic Download of NED Terrain Data 

Users can now automatically download USGS National Elevation Dataset 

terrain data files for projects located in the United States. Select the 

WebGIS button and choose either 1/3 arc-second (~10 meter) or 1 arc-

second (~30 meter) resolution. 

 

NOTE: This feature is only available for users with current maintenance. 

If you are receiving this update as part of your maintenance, once your 

maintenance expires, you will no longer have access to this feature. 
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Topic Feature Description 

Terrain 

Processor 

AERMAP Domain Selection 

Consistent with the latest AERMAP executable release by the U.S. EPA, 

the Terrain Processor defaults to unspecified domain extents when 

running AERMAP. With this option enabled, AERMAP will process the entire 

terrain file when calculating elevations and hill height scales. 

 

Terrain 

Processor 

Buffer for WebGIS Terrain Downloads 

All maps downloaded from the WebGIS button will include a 5% buffer 

region. The buffer will help protect projects located close to edges of 

terrain files that their project domain will be covered. 

Terrain 

Processor 

Extended Support for Large Domains 

Internal changes were made to reduce incidence of memory errors (e.g., 

“Table is full”) which prevented the Terrain Processor from handling 

data which covered a large domain or when the number and resolution of 

terrain files was very large. 
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Topic Feature Description 

Terrain 

Processor 

Optimized Elevation Import  

The process for importing elevations to model objects, after AERMAP has 

been run, was optimized for faster processing times.  The options under 

the Import Elevations/Hill Heights dialog were simplified for easy of use. 

 

Details Additional Warnings in Details 

AERMOD View will now warn you if a Source and/or Building have a base 

elevation of zero while receptors do not. 
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Topic Feature Description 

Graphical 

Options 

Default Contour Shade Style set to Transparent 

Results contours will now default to the Transparent Shade Style after 

the model is run. This change makes all lower-layer overlays (e.g., base 

maps) easier to see beneath the results contours. Also, the Alpha Blend 

option was renamed Transparent option for easy understanding. 

 

Graphical 

Options 

New Default Level Options for Concentration Contours 

Contour levels are now set using the Natural value distribution algorithm 

by default. The Natural algorithm creates rounded level values (e.g., 10, 

20, 50, 100, 200, etc.).  

The default minimum value is now defined as the maximum between the 

plot minimum value and the plot maximum value divided by 100. 
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Topic Feature Description 

Annotation 

Toolbar 

Transparency Option for Annotations 

A transparency level can be set for all annotation objects. 

 

Annotations Last Selected Annotation Settings 

Last selected settings for the Annotation tools will now be saved. These 

settings will be applied globally – the changes made in one project will be 

applied to annotations made in the next project until changed again. 

Contour 

Legend 

Emission Output Labels on Legend 

Resolved a problem with deposition plots where the contour legend did 

not display the user-specified emission output unit. 
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Topic Feature Description 

Order Met 

Data 

New Link under the Help Menu 

The Order Met Data link is now available under the Help menu.  This link 

connects to the Request Met Data quote online form available in the 

webLakes.com site. 

 

Run Batcher and Multi-Chemical Utility Shortcuts 

You can access the Batcher and Multi-Chemical Utility by clicking on the 

Run menu toolbar button. 
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Topic Feature Description 

Multi-

Chemical 

Utility 

Multi-Chemical Utility Interface Layout Changes 

Small changes have been made to the Multi-Chemical Utility to streamline 

the interface. 

 

Multi-

Chemical 

Utility 

Multi-Chemical Utility Now Generates Plotfiles with Scientific 

Notation for Very Small Values 

The Multi-Chemical Utility can now handle again very small concentration 

values. In AERMOD View Version 7.6, these values were being written as 

zeros (e.g., 0.00000).  In this release, if very small values are detected 

(e.g., 0.0000023), the concentration/deposition results in the plotfile will 

be automatically written all in scientific notation. 

POST View Additional Features Implemented in POST View 

The following menu options/features were introduced in POST View: 

• Import Tile Maps (current maintenance only) 

• Import Raster Images using one menu option 

• Print to PDF option under the File menu 

• Transparency options for Annotation tools 

 


